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DM-II™ Explorer Window

The Explorer Window shows all the information relating to the charts. user defined profiles. and
datsets of a database. This window cansists of two areas. The left side disolays the Foider Box.
This shows the Charts and the User Defined Profiles folders. as weil as any Datasets that have
been created in User folders. All of these folders are stored under the DM-1I™ Database labeled

at the top of the window. The right side is cailed the Folder Contents Box. which is used to show
information related to the item seiected.

52 DM-11 Explorer C\DMIIVIEWASAMPLEMDB

User Defirud Prosile

132W
=] & CMi Datapase g DML
—af Charts =28k
C-mm User Defined Profiles
B% Factor Detau ok . "WhenStart Pushed
Uset Foider : "When Memory ful
1 Second
15 Mirmites
Normal

TRMS [RMSmax
TRMSmun [RMSavg
TPeak . D Power

- - -
Folder Folder Contentcs
Box Box

'When datasets are available for viewing, the Folder Contents Box snrinks. and a Parameter List

Box appears. This box shows parameters that have been recorded in the dataset from which a
cnart or data sheet can be generated.



{43 DM-il Explorer  CADMIIViewiSample mdb

Datasat

Phase Type: 104W Wie

= E OM4 Data Base

‘g Chart IStan Time: /8197 9.48:56 AM
(=>-mm User Defined Profiles i{Stop Tire: SB97 $:49:44 AM
I LI Factory Defaui ‘[Rate: L Zec
E"@ Public Service Data Points: <9

; L-Eﬂ Data trom Pusiic Service
(=477 Mile High Power

S B Datatom Mits High Pawer

Datasec

{{Paramaters:

Paramecer List Box

By right clicking the mouse while either a chart. user defined profile, or dataset is selected. a
Folder Box Popup menu wiil appear allowing the user to perform various functions. With a
parameter selected. right clicking of the mouse will show a Parameter List Box Popup allowing
the user to display a chart. data sheet. or parameter information.



'Editing The Explorer Window

The names in the Folders Box can be renamed directly. To edit a name. the user selects an item
and then presses the ~Z key. This erases the name and enables eqiting for the item. Pressing
the Escape key wiil abort the edit.and the name will revert back to the original name. Pressing
the Aeturn key, or the Up or Down Arrow keys before entering any other key will-also abort the
editing function. Pressing them after typing any characters will cause the name to be changed in
the Explorer Window as well as in the database. )

Note: Four items in the list can not have their names altered: DM-II™ Database. Charts folder,

User Defined Profiles foider, and Factory Default Profile.
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Downloading Data from the DM-1I™

The DM-II™ needs to be linked to a vacant senal port of the personal computer via the RS-232
cable wnich is supplied. The OM-i™ RS-232 port is located at the top of the battery
companment. The RS-232 cable needs to be hooked up prior to attempting to downloading the
data set. The first step is to connect the OM-II™ to your computer through a serial cable. The
communications settings may need to be changed for the computer. To change the baud rate, -
the user selects Tools, then Options. and under the General page sets the appropriate
Communications Port and Baud Rate. The Baud rate selection depends on the speed of the

user's PC.

DOM-ll View™ To PC Serial Port Test: If the-user selects Toois then Options then Port and then
sets it to Auto. the DM-II View™ wiil automatically search for and select the proper
communications port that the DM-1{™ is connected to.
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Communicaticns Part (COM1)

After the DM-II™ is connected to the computer, the DM-II™ shouid be set to the COMM SETUP
screen. When the proper baud rate is salected. the DM-1| View™ wiil show On Line in the Status
Bar and the OM-II™ will flash Connection Ckay. Allow suificient time for verification of
cennection.

With the OM-II™ connected and responding, the user can start a downioad in the DM-il View™
software by selecting the Downioad Dataset option on the OM-/I™ menu or by selecting it from
the Tool Bar.

The download dataset cption requires the user to give the new dataset a name and folder
‘ocation. The user can also orovide attribute information that will be savea with the dataset. The
downioaa monitor wiil appear aiter the download has been initiated. This wiil provide the user
with the status of the downioad process.
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Staius Bar

The Status Bar informs the user of the connection status tc the DM-1I™. communications port
settings, Tool Tips, time. and o(pé; software information.
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Download Dataset

Qownload Dataset ailows the user to downioad recorded data from the DM-1I™ and placeitina
2atabase. There are two ways to initiate a cownioad from the DM-II™: by selecting it from the
OM-II™ Menu or the Tool Bar. The Downicad Dataset window appears if the DM-1I™ is On-Line.
"his window allows the user to name the gataset and determine its location in the database. The
'ocation of where the data was recorded may be entered.
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After entering the recording information. the user clicks the Downioad button which wnil'dxsplay'
the download monitor. This informs the user of the progress of the downiocad. The mongtor
Zisplays the amount of bytes sent along with any errors that have occurred in the transter
crocess. The user can cancei the transter at any time and the data wiil not be entered into the
database. A progress par dispiays the cercentage of the downioad finished in the Status Bar.
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A Updating Database window will appear showing a progress bar indicating percentage of
database updated. The database is only ucdated with the downioaded data if a complete transfer

has occurred.

Note: A large recording session that is downioaded to a slower machine wiil take time to update
the cata base. Please wait until completed to assure comptete access to the recorded data.

Updating Database




Repairing a Bad Database

A database can become corrupted on the disk. In some cases. the data can be recavered
througn the Aepair Datapase funétion under Database Utilities of the Tcois Menu.Load

I

Load Dataset from File

Load Dataset from File allows the user to download recorded data from a file. This option may
only be selected from the DM-1I™ menu. When selected. a window appears that allows the user
to select a name and location for the dataset in a User Folder. '
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After entering the recording information, the user clicks the Fileload button which will display an
Open Window. From this window. the user selects the location of where the file is stored. All
stored files have a BIN extension. Pressing OK wiil then bring up the Update Monitor showing a
percentage of database update.



Folder Box Popup

The Folder Box Popup menu grovides right mouse-access to cenain features of the
apptication. ;.
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The following menu items are provided:
« New provides a sub menu in which to choose Folder or Chart.
« Folder allows new folders to be created. New folders can only be created when a

User folder or the DM-1I™ Database is selected. Main foiders are created when a
new folder is added under the OM-1I™ Database. A sub folder is created when a new

folder is created unaer a User folder.
e Chart brings up the Chart Properties window allowing the user to create a new chart.
« Open opens the selected item which can be a User Defined Profile. Chart. or Dataset.

Note: Open is enabled only when a Chart. Dataset or User Defined Profile is selected.

o Delete ailows the user 10 delete User Named Folders. Catasets. Charts and User
profiles.

The Delete function may also be selected by pressing the delete key on the keybeard.
The Delete function is cisabled on datasets that have saved chans linked to them. if a
user desires to remove a dataset that fias a connected chart they must first removed the

charts that are connected. %

e Rename ailows the user to rename User Named folders. Saved Charts. Datasets and
User Defined Profiles. This function is also avaiiable by pressing the F2 key.

o Praoperties provides information on Datasets and User Named Folders. This can also be
accessed on the Tooi Bar.
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Parameter List Box Popup

The Parameter List Box Popup allows the user to produce a Chart or Data sheet from a
datasat. In aadition, properties of the gataset can be viewed.

¢ Chart displays the chart.fo‘r'fhe selected parameter.
* Data sheet dispiays the data sheet for the selected parameter.

» Properties show general information on the dataset.

-
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Tool Bar

The Tool Bar allows quick access to the more commoniy used functions available from the
menu bar. When the usar passes the maouse over the Tool Bar selection. Tool Tips will appear to

provide context sensitive help. TooLtips are also visible in the Status Bar.

User Detined
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Chart
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Tool Tips

A Popup box will appear when the mouse is over a tool bar button. The popup box gives the
function associated for that button. {
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Menu Bar

The Menu Bar provides access to all of the functions of DM-1l View™. 4 pull down menu
appears when one the menu items is selected with the left mouse button. The A{t key allows the
user to use the keyboard to access g particular menu. The underlined character in gach menq
indicates access via a keyboard character. Shortcut keys are also provided to the right of each
item in the pull down menu.

The following menus are provided:
e File Menu

*» View Menu
e DM-I™ Menu - S
¢ Tools Menu

o Window Menu

-

e Help Menu

[ et

For Help, press F1. s
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File Menu

The File Menu provides access to functions that are used to medify the selected database. This
menu Is also used to exit the program.

The following menu items are _pfoxfided:

N

New Database allows the user to create a new database.

Open Databasa allows the user to open any available database. Clicking on this option
will bring up a file diaiog box to select available databases.

Save Database As allows the user to save the open database under a different name.

Close Database closes the open database. Repair can only be performed on a closed
database.

Open opens the selected item which can be a User Defined Profile, Chart. or Dataset.

This is enabled only when a Chant. Dataset or User Cefined Profile is selected.

New provides a sub menu in which to choose Folder or Chart.

» Folder ailows new folders to be created. New folders can oniy be created when a
User rolder or the DM-1I™ Database Is selected. Main foiders are created when a
new folder is added under the DM-1I™ Database. A sub folder is created when a new
folder Is created under a User folder.

» Chart brings up the Chan Propefties winaow ailowing the user to create a new chart.

Delete ailows the user to deiete Chants. User Definea Profiles. Datasets. and User
folders.

The aelete function may aiso te enabled by pressing tne delete key on the keyboard.



.The delete function is disabled on datasets that have saved charts linked to them. If a
user desires to remove a gataset that has connected charts. they must first remove the
charts. '

Rename allows the user to rename Charts. User Defined Profiles. Datasets. and User
foiders. This function is aiso available by pressing the F2 key.

Properties provides information on Datasets and User folders. This can also be
accessed on the Tool Bar.

Save Chart allows the user to save a chart. This function only exists when a dataset has
been charted.

Print allows the user to print a chart or data sheet depending on which one is selected.

-

Exit exits DM-II View™ software.
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View Menu

The View Menu provides the user the apility to display the Tooi Bar or Status Bar.
he following menu items are provided:

* Tcol Bar

« Status Bar

« Chart Size selects the initial size for new charts before they are created. Chart s?zes
relate to the main window size. Exampie: ' , the chart takes up Y% of the main window.

-~
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DM-{I™ Menu

The DM-II™ Menu allows the user to downioad a dataset. load a dataset from a file, or to create
a User Defined Profile.

The following menu items are provided:

o Downiocad Dataset
o Load Dataset from File

o User Defined Profile.

a.



Tools Menu

/ The Tools Menu pravides access (o the catabase utdities and system options.
: The foilowing menu items are provided:
+ Database Utilities provides a sub menu in which to choose the following:

» Backup Database allows the user to backup a DM-II™ database.

» Repair Database allows the user to repair.a DM-1I™ database.

Note: The user can not repair the currently loaded database. The database must be
closed before a repair is attempted. :

» Compact Database makes a rearranged copy of the database files and stores it on
disk. Compacted files are usuaily smaller and often provide better performance.

i
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+ Options.

Window Menu

The Window Menu ailows the user (0 view windows in various arrangements.

The foilowing menu items are provided:
» Cascade allows the user to arrange the windows in a cascading fashion.

» Refresih allows the user to refresn ithe Explorer Window to its onginal state.




Help Menu

The Help Menu provides access to the Help dialogue.
The following menu items are provnaed

» Contents dispiays the contents of the help file.

* Search For Help On allows a search for function description or definition in the help
file.

Technical Support displays information on how to get technical support.

The About DM-II View™ shows general information about this appiication software.

-
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Creating a Chart

Creating a Chart can be accomplished several different ways. The quickest method is to first
select the desired parameter in the parameter iist box. Right clicking the mouse wiif bring up a
Parameter List Box Popup menu from wnich the user selects the chart function.

An alternative method is to right mouse click on the dataset which will bring up the Foider Box
Popup menu from which the user can select New and then Chart. This will bring up the Chart
Properties window. The user then selects the desired parameters fromi the left hand list. The user
“an then cecide to create the default chart with the selected parameters or make changes to the
nart layout. The chart wiil then pe disoiayea by ciicking on the OK button. The user may aiso
Cpen a previously created chart by right mouse clicking the selected chart in the Foider Box.
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Cnee the chart is displayed on the screen it can be printed. saved in the qatabase. modified. or
ciosed.

Arinting or saving the chart can be done by salecting Print or Save Chart from either the Tool Bar
r from the Fiie menu.



Chart Information

The Chart function displays data for the user to viewand/or pnnt. Scroiling through the data can
be accomplished by using the arrow keys or the mouse. The upper left corner of the cnart
displays the time and date at thg"location of the scroil bar. The minimum and maximum values
of the data set are also displayed. Point refers to measured vaiue of data at the scroll bar. If the

data consists of all zeros. no scroil bar is present.
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After the chart is displayed. items are automatically added to the tool bar. They are Zoom In.
Zoom Qut. Normal Zoom, Increase Gain. and Decrease Gain. The zoom items change the range
of the values on the X-Axis on the chart. The Zoom items are also added to the menu bar for
access with a mouse. The gain items change the range of the vaiues on the Y-Axis of the chart.
The gain function is only available on the tool bar. ‘




Chart Properties

The Chart Properties form allows the user to custorruze the setup of the cnart's display. Several
pages are avaiable allowing the user to adjust different chart characteristics.

The Parameters Page allows the. User to select which parameters of the dataset to dispiay.
Multiple parameters from the same dataset may De selected to be displayea on tr}e same chart.
The Properties selection shows general information of the seiected parameter. Clicking on Data
Sheet will bring up the data sheet.
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The Axis Page allows the user to change fonts. text, orientation, and placement of axis labels.
The axis labels can also be removed fr

om the chart by using the /s Showing check box.



£ Chart Praperties
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The Chart Group page allows the user to edit the legend data. The legend can also be
eliminated by deselecting the Show Legend checkbox . The Group selection relates to the two Y
axis on the chart.



On the Titles Page the user can edit the displayed titles. change the font of tltles a/ndsidlxi;
their placement. The titles can also be turned cff from the chart by deselecting the /s Showing
checkbox.



Data Sheet

The Data Sheet displays the data of a parameter in tabular format.
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The user may select any parameter of the dataset to be displayed.

The user can adjust how the data is viewed by using the scroll bar. The scroll bar arrows
adjusting the dispiayed data to the top or tottom of the data set. one page at a time, or one line
at a time. The user can also move through the data by using the arrow Keys and the page up or
page down keys.

Clicking on the Charr button wiil preduce a cnart of the selectea parameter. unless the parameter
has only a singie data point. Clicking on the Goto button wiil bring up the Goto window. This
allows the user to quickly move througn the data to a particular point. The Methed choice ailows
the user to jump to a point in the data shest based on the row number or time. The Goto point
may also be scrolled to by using the mouse or the Right or Left arrows.
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User Defined Profiles

This window allows the user to configure the DM-1I™ for a data recoraing session.

Defined Prafile: Default
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The Setup page allows user to select phase type. time settings, and hardware settings. Once
setup is selected. the user can load the profile to the DM-{I™ by clicking the Send button. The
Start and Stop buttons controi the recording session on the DM-II™. Send. Siart. and Step will
only work wnen the DM-II™ is On-Line. Save aliows the user to save the profile to the database.



Options

The Options selection allows tne user (o change the look and operation of the GM-H View™
software. -

-

Facto Detaut

Commurucaucns Post (COM 1)

The General Page has settings for the communications port, profile defaulit settings an‘d béckup
prompt options. Clicking OK or Appiy causes the changes to be updated in the DM-Il View™
software.



The Explorer View Page allows usat.to change the font type, size, and color used in the
explorer screen. The selected font is displayed.
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DMIIVIEW.INI File Description

This section cantains information about the applicatiein that wiil be stored in the OMIIVIEW.INI

tile.

Th'is file is created when software 1 installed and updated with option changes during running of
sofitware. This file is located in the Windows directory. Changes can be made by user directly.

Caution: Manually changing these settings might cause GM-il VIEWT™ software to not

operate property.

IN! Sections/Keywords Description

tApplication]
CurrentDB =
User Name =

User Qrganization =
AppPath =

User Product Number =

:nformation).

iGeneral]

ShowToolBar = -1
ShowStatusBar = -1
ShowToolTips = -1
DBBackup = 2

Language = 1

(Position]

FormTop =0
FormlLeft =0
FormHeignt = 8520
rormWidth = 11880

Current Database being used. . .
User name entered during installation. '
Company name entered during installation.

The directory where the DM-II View™ software is loaded.
Product identification numper (Vgrsion and Release

Tool Bar displayed? -1 = yes , 0 = no

Status Bar qisplayed? -1 =yes, 0=n0

Display; Tool Tips? -1 = yes. 0 = no

Prompt for when Database Backup occurs

0 = at program starn. 1 = at program close, 2 = No Prompt

English = 1

The starting location of the MDI application.
The starting location of the MDI appiication.
The starting size of the MD! application.
The starting size of the MDI aoptication.
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